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Curved Mirrors and Images 
INTRODUCTION 
While we all feel familiar with the images we see in plane mirrors, our experiences with their 
curved counterparts might be limited to cosmetic mirrors or the side view mirrors on automobiles. 
In this experiment, you will explore the characteristics of the real and virtual images formed by 
curved mirrors. Then you will develop a mathematical relationship describing the relationship 
between the positions of the object and the real image formed by concave mirrors. 

 
OBJECTIVES 
In this experiment, you will 

• Use curved mirrors to produce real and virtual images.  
• Explore how the position of the object affects the appearance, orientation, and size of real 

images produced by concave mirrors. 
• Explore how mirror characteristics and the position of the object affect the appearance, 

orientation, and size of virtual images produced by concave and convex mirrors. 
• Determine the relationship between object distance, image distance, focal length, and 

magnification in real images produced by concave mirrors. 
 
 
MATERIALS 

Logger Pro or LabQuest App Vernier Mirror Set 
Vernier Dynamics System track small plane mirror 
Vernier Optics Expansion Kit  

 
 
PRE-LAB INVESTIGATION 
1. Place the convex mirror at one end of the track. Position your eye at the other end of the track 

and examine the image of yourself. In what way does the image of yourself differ from that 
which you would see if you were looking into a plane mirror? How does the image change 
when you move the mirror closer to you? 

2. Replace the convex mirror with the concave one and move it to the end of the track. As you 
did before, position your eye at the other end of the track and examine the image of yourself. 
In what ways does the image of yourself differ from that which you observed with the convex 
mirror? What happens to the image when you move your head slightly from side to side?  

3. Gradually move the concave mirror closer to you. How does this affect the image you 
observe? What happens to the image when the mirror is approximately 20 cm from your eye? 

In your class discussion, you will learn how the use of ray diagrams can help you to determine 
how and where light from a particular point on an object converges to form an image. You can 
get a conceptual understanding of the process of image-formation by a curved mirror using the 
simulation available at the Davidson University web site.1 

                                                
1 webphysics.davidson.edu/course_material/py230L/optics/lenses.htm 
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PROCEDURE 
Part 1  Concave mirror and real images 
1. Set up the light source and concave mirror to project a clear image on the half screen. 

a. Attach the light source assembly from 
the Optics Expansion Kit to the Vernier 
track. Position it so that the pointer in 
the base is at the 10 cm mark and the 
light source faces the other end of the 
track.  

b. Place the concave mirror near the other 
end of the track so that it faces the light 
source. Attach the half screen to the 
track between the light source and the 
mirror.  

c. Turn the light source wheel until the 
number “4” is visible in the opening. 
This will be your “object” for this 
investigation. 

d. Adjust the position of the screen until 
the image of the “4” on the screen is in 
focus (see Figure 1). You may need to 
adjust the angle of the mirror in its 
holder so that the image projected by 
the mirror shows on the screen. One 
approach to obtain the sharpest image, 
once you think you have it, is to move 
the screen in either direction until the image begins to blur, then move it back until it again 
appears sharp.  

 
2. Describe the size, shape, and orientation of the image. 

3. Now, move the mirror to the 100 cm mark, then move the screen toward the mirror until you 
can see a sharp image of the “4” on the half screen. Record the distance between the light 
source and the mirror as “object distance” and the distance between the mirror and the screen 
as “image distance” in your lab notebook.  

4. Obtain object distance and image distance data for four more points, moving the mirror 10 cm 
closer each time. Note what happens to the size of the image as the object distance decreases. 

5. Move the mirror to the 50 cm mark, leaving the light source at 10 cm. Note that you cannot 
obtain a sharp image on the screen. If you remove the screen and rotate the mirror slightly, 
you can observe a sharp image of the “4” on the light source assembly itself. Compare the size 
of the image to that of the object. 

6. It is possible to obtain another data point for which the mirror is even closer to the light 
source. To do so, move the light source to the middle of the track and the mirror 30 cm away. 
Hold the screen off to the side behind the light source and rotate the mirror until you can 
observe the projected image on the screen. Make your best estimate of the image distance. 

Part 2  Convex mirror and virtual images 

Figure 1 
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Locating a virtual image is more difficult because it cannot be projected onto a screen, like a real 
image. The technique described below involves the use of parallax to determine the position of the 
virtual image. 

1. Draw a vertical line on a 3″ × 5″ index card; place 
this card in the slot on the full viewing screen. This 
screen is your image position marker. Place the 
half screen (which serves as the object), convex 
mirror, and full screen on the track as shown in 
Figure 2. 

2. Move the convex mirror to a position 40 to 50 cm 
from the half screen. Record this as the object 
distance. Stand at the end of the track near the half 
screen so that you can view both the virtual image 
of the half screen and the index card attached to 
the full screen. 

3. Place the index card and screen serving as the 
position marker just behind the convex mirror. 
Position your head directly behind and above the 
half screen. As you look over the top of the half 
screen toward the mirror, you can view the half 
screen in the mirror. Move your head so that the 
line on marker and the edge of the half screen are 
aligned. 

4. Move your head to the right of the half screen. 
Note that the edge of the screen in the image 
appears to the right of the line on the marker. 
When you move your head to the left of the half 
screen you should note that the edge in the image 
shifts to the left of the marker line. (See Figure 
3.) This difference in relative positions is called 
parallax. 

5. Move the marker 5 cm farther from the mirror. 
When you repeat Step 4, the parallax is reduced. 
Gradually move the marker farther from the 
mirror and check the alignment of the edge of the 
half screen and the line on the marker until there 
is no parallax. Record this distance as the 
distance of the virtual image. If you go beyond 
the no-parallax point, the image and the object 
will move in opposite directions. 

 
EVALUATION OF DATA  
1. Choose New from the File menu in the data-collection program. In the table, manually enter 

your data for your measurement with the concave mirror. Enter d-o (for object distance) and 
d-i (for image distance) as the Names of the columns. 

Figure 2 
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2. Examine your graph of image distance vs. object distance. What relationship appears to exist 
between these variables? Rather than performing a curve fit to the data, take steps to modify 
one of the variables so as to produce a linear graph.  
Using Logger Pro 

 Choose New Calculated Column from the Data menu. After entering a name and units for the 
column, click the equation field, enter the expression to modify the variable you choose from 
the drop-down menu, then click Done. Change the variable on the axis you have chosen to 
modify to see the resulting graph. 

Using LabQuest App 
 Choose New Calculated Column from the Table menu. After choosing a name and units for 

the column, select A/X as the Equation Type. Enter the column you wish to modify, then 
select OK. Tap the Graph tab and change the variable on the axis you have chosen to modify 
to see the resulting graph. 

 You may find it necessary to modify the variables on both axes to linearize the graph. When 
you have done so, write the equation of the best-fit line. 

3. Examine the value and the units of the slope. Discuss with your instructor what the ideal value 
of the slope might be.  

4. Examine the value and units of the vertical intercept. In view of the modifications you made to 
the object distance and image distance in order to produce a linear graph, draw a conclusion 
about the physical significance of the intercept. 

5. Write a general equation of your best-fit line in terms of di, do and f; rearrange the equation so 
that di and do are on the same side. Compare your results to the spherical mirror equation in 
your text or a web-based resource. 

6. The magnification, m, of an image is the ratio of the image height, i, to the object height, o. 
Using similar triangles, one can show that it is also equal to the ratio of the image distance to 
the object distance.  

o

i

d
d

o
im −==  

 Note: the negative sign is included as part of the convention to indicate that the real image is 
inverted.  

 Find a configuration of the mirror and the screen that produces an image of the “4” used as 
the object that measures 10 mm across. Measure di and do and compare the agreement 
between the two ratios. Repeat this process for an image that is half as large. The “4” on the 
light source is 20 mm across. 

7. In the sign convention used for spherical mirrors, both the focal length of a convex mirror and 
the image distance for a virtual image have negative values. The focal length of the convex 
mirror in the mirror set is –20 cm. Use the spherical mirror equation to calculate the expected 
distance for the virtual image. How does this compare to the value you obtained from your 
observations? 

EXTENSIONS 
1. Suppose you had used a 15 cm concave mirror in your experiment. Predict the slope and 

intercept of the graph of 1/di vs. 1/do. 
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2. In what ways are the virtual images one can see with both convex and concave mirrors the 
same? How are they different? 

3. Determine the virtual image distance for at least five more positions of the half screen serving 
as the object as you did in Part 2. Create a new Data Set in your Logger Pro or LabQuest 
App file and enter the values for the object and image distances. Insert a new graph and 
choose 1/di as the vertical axis label and 1/do as the horizontal axis label. Apply a linear fit as 
before and determine the agreement between your data and the spherical mirror equation. 
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Curved Mirrors and Images 
In this lab, students first examine real and virtual images formed by concave and convex mirrors. 
Then they collect the data used to derive the spherical mirror equation, which has the same form 
as the thin lens equation. If you choose to have your students perform this experiment, you may 
wish to skip Experiment 16, because in it, students accomplish similar goals with lenses. 

This lab is written with the assumption that the instructor will engage the students in discussions 
at critical junctures. These discussions can take place with the entire class or with individual lab 
groups. The icon at left indicates where these discussions should occur. 

The Microsoft Word files for the student pages can be found on the CD that accompanies this 
book. See Appendix A for more information. 

 
OBJECTIVES 
In this experiment, the student objectives include 

• Use curved mirrors to produce real and virtual images.  
• Explore how the position of the object affects the appearance, orientation, and size of real 

images produced by concave mirrors. 
• Explore how mirror characteristics and the position of the object affect the appearance, 

orientation, and size of virtual images produced by concave and convex mirrors. 
• Determine the relationship between object distance, image distance, focal length, and 

magnification in real images produced by concave mirrors. 
 
During this experiment, you will help the students 

• Recognize that a real image is the result of the convergence of rays emitted from a point 
on an object. If a screen is placed at the plane of the real image, then many observers can 
see it. 

• Recognize that a virtual image perceived by a viewer forms behind the mirror at the 
location from which the diverging rays reflected by the mirror appear to have originated.  

• Recognize that the slope of the graph of 1/di vs. 1/do is ideally equal to –1 and that the 
intercept is the reciprocal of the focal length.  

 
 
REQUIRED SKILLS 
In order for students to succeed in this experiment, they must know how to 

• Create calculated columns in the software so as to linearize a graph. Calculated columns 
are addressed in Activity 3 in Advanced Physics with Vernier–Mechanics. This activity 
can be found on the CD that accompanies this book. 

• Perform linear fits to graphs. Linear fits and linearzing data are addressed in Activity 1 in 
Advanced Physics with Vernier–Mechanics. This activity can be found on the CD that 
accompanies this book. 
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EQUIPMENT TIPS 
For this experiment, we recommend using the Optics Expansion Kit and the Mirror Set with the 
Vernier Dynamics System track. It is certainly possible for students to observe the formation of 
real images with mirrors and to collect the data that will enable them to derive the spherical 
mirror equation with other apparatus. There are several advantages to using the equipment in the 
Optics Expansion Kit and Mirror Set. The holders for the light source, mirrors, and screen snap 
onto the dynamics track so that these optical elements remain well aligned when they are moved; 
also, the fiducial marks in their bases enable one to readily locate their positions. The concave 
mirror can be rotated on its axis, allowing the projected image to be viewed when the mirror is 
close to the light source. The object distances specified in the procedure are predicated on the use 
of the 20 cm concave mirror in the kit. If you use another focal length you should make 
adjustments so as to ensure that students obtain data for object distances corresponding to c and 
between c and f.  

 
PRE-LAB DISCUSSION 
The Pre-Lab Investigation allows students to observe characteristics of the virtual and real 
images from curved mirrors. Students may, at first, think that the image from the convex mirror 
is no different from that observed in a plane mirror. If they do, have them place a small plane 
mirror on the track just below the convex mirror so they can simultaneously view their images in 
both mirrors. While both are upright, the image in the curved mirror is smaller and easier to 
center than that viewed in the plane mirror. The image in the curved mirror gets slightly larger as 
the mirror is moved closer to the observer. With the plane mirror, the situation is more 
complicated. The image may appear larger when the plane mirror is closer, but it fills the same 
fraction of the mirror regardless of the distance. 
When the concave mirror is placed at the end of the track, students observe an inverted image of 
themselves. It is important for students to recognize that the image is not merely inverted, it is 
real; i.e., light rays emanating from each point on the object are reflected by the mirror and 
converge at a point in front of the mirror. If a screen were placed at this location, the image could 
seen by observers not directly in line with the center of the mirror. 
This investigation sets the stage for the use of ray diagrams to determine the location and size of 
the image for both concave and convex mirrors. The java applet at the Davidson University web 
site1 gives students the opportunity to explore how moving the position of the object relative to 
the mirror affects the image location and size. While not as elegant as the one that shows ray 
diagrams for images formed by lenses at the PhET web site, it is certainly helpful. 

 
Figure 1  Java applet 

                                                
1 webphysics.davidson.edu/course_material/py230L/optics/lenses.htm 
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LAB PERFORMANCE NOTES 
The LED in the Light Source Assembly is bright enough that students should be able to 
determine when the image is in sharp focus if the ambient lighting is not too bright. However, it 
is helpful to dim the lights when the students investigate the magnification – the final step in the 
Evaluation of Data. 

In Step 5, when the object is at c = 2f, the image may be observed on the front of the light source 
assembly if the screen is removed. To view the image when the object distance is between c and 
f (in Step 6), the mirror must be rotated slightly and the screen held close to the track and behind 
the light source.  

For most, it is difficult at first to locate the virtual image formed by the convex mirror. 
Familiarize yourself with the procedure outlined in Part 2 so that you can assist students who 
find the no-parallax technique difficult to master. 

 
SAMPLE RESULTS AND POST-LAB DISCUSSION 
Steps 1 and 2 

The plot of image distance vs. object distance appears to be a hyperbola but one that does not 
have the asymptotes at the coordinate axes (see Figure 2). 

  
Figure 2 
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Students are likely to conclude that the image distance, di, is inversely proportional to the object 
distance, do. However, they will find that the standard technique of plotting di vs. 1/do does not 
produce a linear graph (see Figure 3). 

 
Figure 3 

Inversion of the image distance is also required in order to obtain a linear graph (see Figure 4). 

 
Figure 4  Linearized graph 

 
For the graph shown above, the equation is 

 

1 di = −1.01( )1 do + 0.0504 1 cm. 
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Steps 3 and 4 

The units of the slope, 

 

1 cm 1 cm, cancel completely. The value, in this case, –1.01, is very 
nearly –1. Students may need to be reminded that their experimental results are unlikely to be 
ideal. The vertical intercept has units of 1/cm. Given that the variables on the axes of the original 
graph were replaced by their reciprocals, it is not unreasonable for students to conclude that the 
reciprocal of the intercept is physically significant. In fact, the vertical intercept is 1/f. 

Step 5 

Once students have reached the conclusion that the ideal value of the slope is –1, they should be 
able to express the general equation describing the relationship between the object and image 
distances as 

 

1
di

= −
1
do

+
1
f

 

When this equation is rearranged to get the two distance terms together, one obtains the spherical 
mirror equation, better known as the thin lens equation. 

 

1
di

+
1
do

=
1
f

 

Step 6 

Students could use the known values of 10 mm for the image size and 20 mm for the size of the 
object to find that do must be twice as great as di. By substituting 2di for do in the thin lens 
equation and solving for di , they could find that the image distance must be 30 cm and the object 
distance 60 cm. But it is much more fun for the students to obtain values of do and di 
empirically, then check their experimental value for m against the theoretical value of 0.50.  

For an image of the “4” to measure 5.0 mm across, the magnification must be 0.25. The required 
image and object distances with this mirror are 25 cm and 100 cm respectively. 

Step 7 

For the –20 cm convex mirror, an object distance of 40 cm should produce an image distance of 
–13.3 cm. 
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1
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Student answers will vary depending on their ability to ascertain the no-parallax point, but they 
should be able to place the marker within 0.5 cm of this distance. 
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EXTENSIONS 
1. The ideal slope of the graph of 1/di vs. 1/do is –1. Based on the experimental results, students 

should expect an experimental value within 3% of this figure. The intercept should be the 
reciprocal of the focal length. In this case, a value of 0.17 1/cm could be expected. 

2. The virtual images from convex and concave mirrors are both upright and appear to form 
behind the mirror. The virtual image from a convex mirror is always reduced in size, whereas 
the one from a concave mirror is enlarged. 

3. A plot of 1/di vs. 1/do for the convex mirror is shown in Figure 5. 

 
Figure 5 

 Student results may vary depending on their ability to judge the no-parallax point to locate 
the virtual image. The slope of the graph is nearly –1 and the reciprocal of the intercept is 
within 3% of the focal length. 
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